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Document conventions

Version control is maintained to provide a history of the changes to this document. The version numbering matches
the corresponding software release version. The most current release is listed first with earlier releases following in
descending order.

Releases of TAB FusionRMS software use the following versioning convention:

[Version # = Major #. Minor #. Build #]. For example, 9.4.0001.

This document applies to all FusionRMS product editions:

‣ Essential
‣ Physical Recordkeeping
‣ Electronic Recordkeeping
‣ Enterprise

Table 1: Version control

Version Date

9.4.1411 November 1, 2016

9.4.1381 April 30, 2016
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FusionRMS Installation Notes

Before you begin

A few changes to the installation process and the minimum system requirements have occurred.

‣ Before installing, you will want to make sure that the server and workstations are running .NET Framework 3.5
SP 1. Depending on the operating systems and network traffic, this can take a considerable amount of time.
Please note that the upgrade to .NET Framework 3.5 SP 1 will require a reboot, which will affect user access
to the server. Consider scheduling this upgrade for a time that will not impact users.
‣ Access databases are no longer supported. If you are installing a SQL Server, you will want to do so before

installing TAB FusionRMS. If you plan on using the free version that ships with TAB FusionRMS, you can
install this prior to the installation of the TAB FusionRMS application. Please note, however, that this will
require a reboot, which will affect user access to the computer hosting the SQL Server. Consider scheduling
this installation for a time that will not impact users.
‣ Review the minimum system requirements below and evaluate hardware for suitability.

Microsoft SQL Server 2008 Express edition

To offer TAB FusionRMS users a more robust system, we now offer all demonstration databases in SQL. Microsoft®
Access databases are no longer compatible with TAB FusionRMS. Microsoft® SQL Server® 2008 and 2008 R2
Express Editions are currently available at no cost from Microsoft.

These versions offer the same reliable and high-performance engine found in other versions of SQL Server and
are suitable for the TAB FusionRMS Demonstration database and small installations. If you do need to convert an
Access database to SQL Server®, we offer a conversion utility inside the SLIM Manager. It is your responsibility to
have the correct SQL environment available for the conversion.

From Microsoft:

The new Microsoft® SQL Server® 2008 Express Edition with Advanced Services is perfect for use as a backend to a
small, multi-user application that requires more advanced features such as Web reporting or full-text search.

Microsoft® SQL Server® 2008 Express Edition uses the same reliable and high-performance database engine as
the other versions of SQL Server 2008. It also uses the same data access APIs such as ADO.NET, SQL Native
Client, and T-SQL. In fact, it is differentiated from the rest of the SQL Server 2008 editions only by the following:

‣ Lack of enterprise features support.
‣ Limited to one CPU.
‣ One GB memory limit for the buffer pool.
‣ Databases have a 4 GB maximum size.

System Requirements for Microsoft® SQL Server® 2008 Express Edition:

‣ Processor type: Pentium III-compatible processor or higher.
‣ Processor speed: Minimum: 600 MHz Recommended: 1 GHz or higher.
‣ Memory (RAM): Minimum: 512 MB Recommended: 1 GB or more Maximum: Operating system maximum.

For more information on SQL Server Express, please visit Microsoft’s Website.

System requirements

The system requirements provide the complete listing of requirements for supported operating systems, database
servers, software, hardware, and storage recommendations; ensure that your version and environment are
evaluated using the applicable system requirements to confirm compatibility.
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Prerequisites
Installation of TAB FusionRMS and some of its capabilities require prerequisite product support.

Databases

A supported version and edition of Microsoft® SQL Server® should be installed, configured, and available for use
before installing TAB FusionRMS.

Microsoft® Internet Information Services (IIS)

IIS should be configured on your server to support Web Access before it is installed.

Devices

The Windows Mobile Device Center must be installed and enabled in order to use the Datalogic Memor X3 or
Datalogic Elf mobile bar-code scanning devices with TAB FusionRMS.

SMTP server

In order to use the e-mail notification feature, there must be an SMTP (Simple Mail Transport Protocol) server
available to handle the actual mail requests for the organization. For example, Microsoft Exchange Server provides
SMTP facilities for sending e-mail messages, as do Sendmail, Postfix, QMail and other products.

The SMTP server may be located inside or outside an organization’s network, but each TAB FusionRMS desktop
client application must be able to make a TCP/IP connection to the SMTP server in order to send an e-mail
message.

Operating systems
TAB FusionRMS is available in both Desktop and Web Access client applications. They are supported by Windows®

client and server operating systems.

Desktop

TAB FusionRMS Desktop is a 32-bit thick client application that will run on 64-bit Windows using WOW64
technology. It includes both workstation and server components that can be installed on Windows client or server
operating systems.

WOW64 (Windows 32-bit on Windows 64-bit), is an emulation layer that enables 32-bit Windows based applications
to run seamlessly on 64-bit Windows.

The application can operate in standalone, network, or virtual environments. Virtualization is supported when
applicable system requirements are met for the guest operating system.

Microsoft® .NET Framework 3.5.1 is required on all workstations and servers running the Desktop client application
and its components. Depending on the operating system, it might need to be installed separately.

Web Access

TAB FusionRMS Web Access is a thin client application that is installed on an IIS web server. Users access the
system with their web browser.

Microsoft® .NET Framework 4.5.2 is required on IIS web servers hosting the Web Access client application.
Depending on the operating system, it might need to be installed separately.

Client operating systems
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Table 2: Supported Windows® client operating systems

Operating system Editions Preinstalled Installed separately Minimum
FusionRMS

version

Windows 10 Anniversary Update 32-bit

64 bit

.NET Framework 4.6.2 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows 10 November Update 32-bit

64 bit

.NET Framework 4.6.1 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows 10 32-bit

64 bit

.NET Framework 4.6 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows 8.1 32-bit

64 bit

.NET Framework 4.5.1 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows 8 32-bit

64 bit

.NET Framework 4.5 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows 7 SP1 32-bit

64 bit

.NET Framework 3.5.1 .NET Framework 4.5.2 9.2 (all)

Windows Vista SP2 32-bit

64 bit

.NET Framework 3.0 .NET Framework 3.5.1

.NET Framework 4.5.2

8.5 (all)

All platforms - we recommend that the latest Windows Service Packs and critical updates are installed to ensure best
compatibility and security.

Windows 7 - the .NET Framework requires SP1.

Windows Vista - Microsoft ends their product support on April 11, 2017.

Server operating systems

Table 3: Supported Windows® server operating systems

Operating system Editions Preinstalled Installed separately Minimum
FusionRMS

version

Windows Server 2016 64-bit .NET Framework 4.6.2 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows Server 2012 R2 64 bit .NET Framework 4.5.1 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)

Windows Server 2012 64 bit .NET Framework 4.5 .NET Framework 3.5.1

.NET Framework 4.5.2

9.3 (all)



 | FusionRMS Installation Notes | 7

©2016 TAB. All Rights Reserved. | TAB Corporate Headquarters | 605 Fourth Street | Mayville, WI 53050

Operating system Editions Preinstalled Installed separately Minimum
FusionRMS

version

Windows Server 2008 R2 SP1 64 bit .NET Framework 3.5 .NET Framework 3.5.1

.NET Framework 4.5.2

9.0 (all)

Windows Server 2008 SP2 32-bit

64 bit

.NET Framework 3.0 .NET Framework 3.5.1

.NET Framework 4.5.2

9.0 (all)

All platforms - we recommend that the latest Windows Service Packs and critical updates are installed to ensure best
compatibility and security.

Database servers
TAB FusionRMS uses Microsoft® SQL Server® as its relational database management system; check the listed
versions, editions, prerequisites, and product minimums listed in this section to ensure compatibility.

Table 4: Supported editions and versions

Server Server
edition

Minimum
server version

Minimum
FusionRMS version

SQL Server 2014 Express

Standard

Enterprise

SP1 (all) 9.3 (all)

SQL Server 2012 Express

Standard

Enterprise

SP2 (all) 9.3 (all)

SQL Server 2008 R2 Express

Workgroup

Datacenter

Standard

Enterprise

SP3 (all) 9.0 (all)

SQL Server 2008 Express

Workgroup

Standard

Enterprise

SP4 (all) 9.0 (all)

The Express editions of SQL Server® require the installation of Advanced Services to support full-text search capability.

Windows software
TAB FusionRMS integrates with specific software applications to provide some of its capabilities; check the
supported versions and product minimums listed in this section to ensure compatibility.
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Desktop supported applications
The TAB FusionRMS Desktop client application supports Microsoft Office integration for Excel, Word, and Outlook.

Table 5: Supported software and versions

Software Software
version

Minimum
FusionRMS

version

Microsoft Office 20161 9.4

Microsoft Office 2013 9.3

Microsoft Office 2010 9.0

Microsoft Office 2007 8.5

Web Access supported browsers
TAB FusionRMS Web Access client application is installed on a web server; users will access the system using their
web browser.

Table 6: Supported browsers

Browser Browser
version

Operating system Minimum
Web Access

version

Internet Explorer (IE) 11 and greater Windows 10 Anniversary Update

Windows 10 November Update

Windows 10

Windows 8.1

Windows 8

Windows 7 SP1

9.3 (all)

Internet Explorer (IE) 9 - 10 Windows Vista SP2

Windows Server 2008 and 2008 R2 SP2

Windows Server 2012 and 2012 R2 SP2

8.5 (all)

Chrome 50 and greater Windows 10 Anniversary Update

Windows 10 November Update

Windows 10

Windows 8.1

Windows 8

Windows 7 SP1

9.4 (all)

‣ Windows Vista - Microsoft ends their product support on April 11, 2017.

1 64-bit is not supported for this version.
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Windows hardware
TAB FusionRMS requires that certain hardware specifications be met; check the listed hardware types, deployment
units, and requirements in this section to ensure compatibility.

Table 7: Minimum recommended Windows® hardware requirements

Hardware FusionRMS deployment Minimum requirement

Hard disk space Server Application installation:

‣ 1 GB minimum free hard disk space.

File storage:

‣ 10 GB minimum free hard disk space.
‣ 40 GB or greater recommended.

Server storage for document imaging:

‣ Server storage space can become an issue when
implementing document imaging; planning requires
consideration of the following factors:

◦ The average image size is approximately 30KB -
45KB per 8.5" x 11" document at 200 DPI.
◦ The number of documents to be scanned as a part

of a back file conversion.
◦ The number of new documents scanned per work

day.
◦ The length of time images remain in the imaging

system.

Workstation Application installation:

‣ 750 MB minimum free hard disk space.

File storage

‣ 40 GB minimum free hard disk space
‣ 15 GB free hard disk space recommended for temporary

file storage.

Server Workstation Application installation:

‣ 2.85 GB minimum free hard disk space.

File storage:

‣ 40 GB minimum free hard disk space
‣ 15 GB free hard disk space recommended for temporary

file storage.

Server storage for document imaging:

‣ This requirement is the same as for the server
deployment unit.

Memory Server System memory:

‣ 512 MB minimum.
‣ 2 GB or greater recommended.
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Hardware FusionRMS deployment Minimum requirement

Workstation System memory

‣ 512 MB minimum.
‣ 1 GB or greater minimum.

Graphics memory

‣ 128 MB minimum.

Server Workstation System memory:

‣ 1 GB minimum.
‣ 2 GB or greater recommended.

Graphics memory

‣ 128 MB minimum.

Processor Server Speed:

‣ 1 GHz 32-bit (x86) minimum.
‣ 1.4 GHz 64-bit (x64) minimum.
‣ 2 GHz or faster recommended.

Workstation Speed:

‣ 1 GHz 32-bit (x86) minimum.
‣ 1 GHz 64-bit (x64) minimum.

Server Workstation Speed:

‣ 1 GHz 32-bit (x86) minimum.
‣ 1.4 GHz 64-bit (x64) minimum.
‣ 2 GHz or faster recommended.

Storage device Mass storage Storage of mass scanned images:

‣ RAID (Redundant Array of Independent Disks) normally
meets scanned image storage needs from 5 - 500 GB
‣ Optical Jukeboxes and Network Attached Storage

devices, such as a SAN (Storage Area Network), should
be considered to meet scanned image storage needs in
excess of 500 GB.
‣ Optical Jukeboxes should be considered when meeting

WORM (Write Once Read Many) storage requirements.

‣ The recommended requirements do not include any additional requirements for other software running on your
system.

Device hardware
TAB FusionRMS supports the use of certain types of peripheral devices for bar-code scanning, data collection,
printing, and document scanning; check the devices, specifications, and product minimums in this section to ensure
compatibility.
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Table 8: Supported devices

Device Description Specifications Minimum
FusionRMS

version

Black and white
thermal label
printers

Small workstation printer used
to print black and white bar-code
labels.

Required:

‣ Microsoft Windows supported
postscript driver that is rated
for label media and printing
volume required
‣ USB port

9.0

Color inkjet
printers

Primarily used to print color-
coded file folder labels, which
can also include bar-codes.

Required:

‣ Microsoft Windows supported
postscript driver that is rated
for label media and printing
volume required
‣ USB port

Recommended:

‣ Separate ink cartridges (black,
cyan, magenta, and yellow)
‣ Provides custom or user

definable sheet size

9.0

Color laser
printers

Primarily used to print color-
coded file folder labels, which
can also include bar-codes.

Required:

‣ A Microsoft Windows supported
postscript driver that is rated
for label media and printing
volume required.
‣ USB port

Recommended:

‣ Toner based cartridges
‣ Paper-type setting for labels,

transparency, or heavy card
stock

9.0

Datalogic Elf A mobile collection device used
to scan bar codes remotely
and then upload the data when
connected to a workstation at a
later time.

Required:

‣ Microsoft Mobile Device Center
‣ USB port

9.3

Datalogic Memor
X3

A mobile collection device used
to scan bar codes remotely
and then upload the data when
connected to a workstation at a
later time.

Required:

‣ Microsoft Mobile Device Center
‣ USB port

9.3
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Device Description Specifications Minimum
FusionRMS

version

Document
scanner

A workstation, workgroup, or
production document scanner
used to convert physical
documents to electronic format
and capturing them for records
management.

Required:

‣ USB port
‣ Kofax compatible scanner

Recommended:

‣ Kofax VRS Elite for basic
image clean up and rescanning
‣ Kofax VRS Professional for

bar-code recognition and image
controls
‣ Kofax Capture for batch

scanning, OCR, and Zonal
OCR.

9.0

Honeywell
Hyperion 1300g

Direct connect barcode scanner. Required:

‣ USB port

9.0

Inateck BCST-10 Bluetooth cordless and direct
connect barcode scanner.

Required:

‣ USB port
‣ Bluetooth 2.1

9.0

Socket 7Ci Bluetooth cordless barcode
scanner.

Required:

‣ Bluetooth 2.1

9.0

Signature Pad Topaz Digital Signature Pad with
USB connector.

Required

‣ USB port

9.0

Upgrade information

If you are upgrading from a previous version, review this upgrade information.

‣ TAB FusionRMS 9.4 will upgrade systems from 9.0 and above.
‣ Once the installation has been started and the progress bar appears, old files will be removed. In order to use

TAB FusionRMS, you must continue with the upgrade once it has begun. If you cancel before the installation
is complete, you will not be able to use the application without uninstalling manually.
‣ During upgrades, 9.4 can run concurrently with previous versions in the same network. However, no changes

can be made in security until all computers have been upgraded to 9.4. This includes the enabling or disabling
of Active Directory.

Feature components

There are several required and optional TAB FusionRMS feature components available for installation. Required
feature components are installed when a TAB FusionRMS system is intially deployed, and optional feature
components can be installed during the intial deployment or at a later date as needed.

Some optional feature components can become required to support features and functions that were previously
not configured. For example, TAB FusionRMS Enterprise provides the capability to manage both physical and
electronic files, but if it was initially deployed and set up to manage physical records and objects but later set up to
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also manage electronic files, then the installation of the Image server feature component to support the Desktop
client and the Image Server Web Service featue component to support the Web Access client would be required.

Each feature component is installed according to the TAB FusionRMS product editions and the following
deployment types it supports:

‣ Server - consists of service and utility components for supporting system functions and features.
‣ Workstation - consists of the core desktop client application and feature set components.
‣ Server workstation - consists of components applicable to both the server and workstation deployment

types.

The following table lists each feature component available for installation and provides a description of their
purpose, the types of product editions and deployments they support, and when they are considered required or
optional. All feature components are installed by using the TAB FusionRMS desktop client application installation
files and procedures.

Table 9: Components

Feature component Description Product edition Deployment type

Image Server Web
Service

A server that is hosted as
a Windows service within
IIS. It controls the reading
and writing of electronic
file attachments from
within the Web Access
attachment viewer to the
electronic file attachment
repository.

‣ Electronic
Recordkeeping
(Web Access client)
- required .
‣ Enterprise (Web

Access client) -
required if managing
electronic files.

‣ Server
‣ Server workstation

Image Service An image server that is
hosted as a Windows
service. It controls the
reading and writing of
images from within the
workstation attachment
viewer to the image
repository.

‣ Electronic
Recordkeeping
(Desktop client) -
required.
‣ Enterprise (Desktop

client) - required if
managing electronic
files

‣ Server
‣ Server workstation

License Manager A GUI interface that
provides TAB FusionRMS
administrators the ability
to manage license
information, database
connections, and user
seat connections. It can
be installed on a network
server,

‣ All editions (Desktop
& Web Access
clients) - required.

‣ Server
‣ Server workstation
‣ Workstation

License Server A server that is hosted
as a Windows server. It
controls system licensing.

‣ All editions (Desktop
& Web Access
clients) - required.

‣ Server
‣ Server workstation
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Feature component Description Product edition Deployment type

Service Manager A server that is hosted
as a Windows service. It
handles retention related
reporting automatically,
such as the Inactive
Records report and the
Eligible for Destruction
report.

‣ Physical
Recordkeeping
(Desktop & Web
Access clients) -
optional.
‣ Enterprise (Desktop

& Web Access
clients) - optional.

‣ Server
‣ Server workstation

TAB FusionRMS Core application
and feature set for
administrator and user
workstations.

‣ All editions (Desktop
client) - optional.

‣ Workstation
‣ Server workstation

Past Due Email Utility A utility that provides
the capability to send
an e-mail notification
when a tracked object is
transferred, requested, or
past due.

All editions (Desktop and
Web Access clients) -
optional.

‣ Server
‣ Server workstation

Database Utility A utility that provides
the capability for adding
databases directly to SQL
Server and registering
them with the License
Server.

‣ All editions (Desktop
& Web Access
clients) - optional.

‣ Server
‣ Server workstation
‣ Workstation

All feature components and FusionRMS should be the same version or operating problems may occur.

Installation

If you are installing on Windows Server 2008 R2, you will need to turn on Microsoft .NET Framework 3.5.1 in the
Windows Features before installing any of the components.

STEP 1: SQL Server Express 2008 or 2008 R2 with Advanced Services (if applicable)

If a version of SQL Server is not installed on your computer, you can install a free version of SQL Express.
Installation times vary depending on your operating system and your version of .NET Framework.

If you have already installed SQL Server Express 2005, 2008 or 2008 R2 prior to this installation, see Known
Issues at the end of this document.

Close all other applications before installing.

If you are installing on Windows Server 2008, you must enable the PowerShell feature. For more information on
Windows PowerShell, please visit Microsoft’s Website.

If you are installing on Windows 7 and Windows Server 2008, you will encounter a program compatibility message
concerning Service Pack 1. Click Run Program. Service Pack 1 will be automatically installed once the SQL
installation is complete.

1. Download and install SQL Server Express 2008 R2 Advanced Edition from Microsoft.
2. Follow Microsoft’s instructions to install SQL Server Express 2008 R2 Advanced Edition.
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For Windows Vista, you must right-click the file, and select Run as Administrator.

3. A list will indicate what components are required. Click Install.
4. The application will begin installing. Your computer may reboot during this process.

On Windows Vista after the reboot, you may not see any indication that the installation is continuing. In the
lower-right corner of your screen, look for an icon concerning applications that need approval to continue at
startup. Open this dialog, and then select the setup.exe file to allow the operation to continue.

During the SQL Server Express installation, create a default user name (sa) and password (1password$). If this
installation of SQL Server is to be used in production, it is recommended that you change the password to secure
access to the database.

SQL Server Express 2008 (or 2008 R2) will install as a named instance even with the default instance selected. This
could cause connection problems with the SLIM Manager. As a workaround you can select the option to install a
named instance and enter "MSSQLSERVER" as the instance name.

STEP 2: TAB FusionRMS application

1. Open the install folder.
2. Double-click the Setup file.
3. The Welcome screen appears. Accept the license agreement by clicking Agree.
4. License Server Location. If you know where the license server has been installed, enter the IP address

and port number. Double-check your entry to make sure you’ve entered the correct information. If you do
not know the location, you can search the network (Note: This may take several minutes, especially if the
license server is not running on the network.) Or, if this is a server, you can skip this step and it will be
installed as a component, or, if this is a workstation, you can skip this step and it will not be installed.

5. Select your installation type:

◦ Workstation: This is for the general end user. Does not include server components or sample
databases.
◦ Server: This is for a network server. It will include the License Manager, Service Manager, Image

Server Web Service, and License Server. The License Manager (SLIM Manager) does not need to be
installed on the server. It can be installed on the TAB FusionRMS administrator’s computer for easier
access.
◦ Server Workstation: Clients without large networks may install all of the server and workstation

components on one computer that acts as the server. Users would need access to this computer to
open a database.
◦ Custom: All components, except the Image Server Web Service and Database Utility.
◦ Sales Demo: All components, except the Image Server Web Service.

6. Review and revise the list of components selected for install. In most cases the list will not need to be
revised.

Selecting an installation type will pre-select the list of components that are needed for that type of installation.

7. Select a new destination folder for the selected components, or click Next to accept the default location.
8. If installing the License Server, find and select your license file. (It can be entered later in the SLIM

Manager.) Click Next to continue.
9. For the services you will be installing, enter valid ports for each one. The default values are already present.

Make note of these ports for future reference during installations. Click Next to continue.
10. Click Install.
11. Sales Demo/Database Utility ONLY: Once the installation is finished, the Database Utility can be launched

automatically. If you have installed SQL Server Express 2008 before installation, this utility will create a
SQL database and connect it to the SLIM Server automatically. Click Add to begin this process. The sample
database will be added to the SQL Server and the SLIM Manager, TAB FusionRMS will launch, and the
database will appear on the log in screen. Enter the user name administrator and the password: password$
to gain access.
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Database Utility

This is an optional utility for adding databases to a local SQL Server and connecting them with SLIM. If your
database is already on SQL Server, you can use the Existing Database feature in Database Utility to connect the
database to SLIM.

ADVANCED USERS: This utility can be used to build and attach a database file, restore a database backup file, or
execute a SQL script on a local or network server.

1. Use the Browse button to locate your file.
2. Enter your server name\SQL instance.
3. To populate the list with network servers, on the Tools menu, click Options, and then select Show Network

Servers.
4. Enter your authentication credentials.

Enter a Display Name. (This is the name you will see on the Log in screen database list.) You can use the
Display Name to name the SQL Server database, or you can enter a unique database name.

5. Click Add.

These advanced features are not intended to be a substitute for SQL Server Management Studio.

One-time database connection credentials

The credentials entered at the time of database connection are what the SLIM Server uses to create or
communicate with the TAB FusionRMS database on SQL Server without Active Directory Integration.

With Windows Authentication:

This simple process only requires that the user logged into the computer running the connection process have
administrative rights to the SQL Server and the Active Directory groups.

‣ In the SLIM Manager, leave the fields blank.
‣ In the Database Utility, select Windows under Authentication.

With SQL Authentication:

This process requires that you enter a Login with the correct permissions created within SQL Server.

‣ In SQL Server, create a Login with SQL Server authentication selected.
‣ For the default database, select the TAB FusionRMS database you will be connecting. (If you are using the

Database Utility, leave the default value master.)
‣ Under Server Roles, select sysadmin.
‣ Under User Mapping, select the TAB FusionRMS database, and then grant the following memberships:

db_datareader, db_datawriter, and db_owner. (Skip this step if you are using the Database Utility.)

In the SLIM Manager, enter the Login. In Database Utility, select SQL and then enter the Login.

Database connection credentials for initial connection and subsequent Active
Directory

The SLIM Server handles the automatic synchronization process of the Active Directory groups and must have
access to both the Active Directory system and the database on the SQL Server through either a fixed Windows
Authentication or a fixed SQL Authentication Login user.

The Windows Authentication method is recommended since it will handle any password changes that may occur;
however, the authentication on the SLIM Server will still need to be changed manually. The SQL Authentication behaves
in the same manner as the Windows Authentication, but any password changes will need to be updated at all levels.

With Windows Authentication (recommended):
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This process begins with the initial database connection and continues repeatedly at a set interval or by the
administrator to update the Active Directory Integration. (For information on manual and automatic synchronization,
see the Synchronization: Manual and Automatic section below.) A fixed login/user will need to be created in
Active Directory, SQL Server, and then entered as a user for the SLIM Server service.

Procedure

1. create a user in Active Directory with rights to Active Directory, SQL Server, and the SLIM Server service.
2. In SQL Server, create a Login with Windows Authentication for this user.

a. For the default database, select the TAB FusionRMS database you will be connecting. (If you are
using the Database Utility, leave the default value master.)

b. Under Server Roles, select sysadmin.
c. Under User Mapping, select the TAB FusionRMS database, and then grant the following

memberships: db_datareader, db_datawriter, and db_owner. (Skip this step if you are using the
Database Utility.)

3. Add this user to the SLIM Server service. In Services, locate the SLIM Server. Right-click the service, and
then click Properties. On the Log On tab, select This account, and then enter the user.

With SQL Authentication:

This process begins with the initial database connection and continues repeatedly at a set interval or by the
administrator to update the Active Directory Integration. (For information on manual and automatic synchronization,
see the Synchronization: Manual and Automatic section below.) A fixed login/user will need to be created in
Active Directory, SQL Server, and then entered as a user for the SLIM Server service.

Procedure

1. Create a user in Active Directory with rights to Active Directory, SQL Server, and the SLIM Server service.
2. In SQL Server, create a Login with SQL Server Authentication that shares the same user name and

password that was created for Active Directory.

a. For the default database, select the TAB FusionRMS database you will be connecting. (If you are
using the Database Utility, leave the default value master.)

b. Under Server Roles, select sysadmin.
c. Under User Mapping, select the TAB FusionRMS database, and then grant the following

memberships: db_datareader, db_datawriter, and db_owner. (Skip this step if you are using the
Database Utility.)

TAB FusionRMS Software Information License Manager and database connection

All databases will need to be added to the Software Information License Manager (SLIM) before they can be opened
in the TAB FusionRMS application.

1. To open SLIM Manager, on the Start menu, point to All Programs, point to TAB FusionRMS, and click
SLIM Manager.

2. View and select options using the SLIM Server Manager tabs.

a. License

◦ View Registration and Dealer information.
◦ View Products, Seats, Features, and Details available with the current license.
◦ To change or add a license, do the following:

1. On the Action menu, click Acquire From Internet
◦ To change or add a license without access to the internet, do the following:

1. On the Action menu, click Load From File.
2. Locate the License Manager File by browsing to the Extras folder in the installation

files.
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If you do not have the installation files and have received the License Manage File by
some other means, copy the file into a network share or local folder, and then browse
to it in order to select it.

◦ To reset the license to Demonstration mode, do the following

1. On the Action menu, click Reset Demo License.
b. Databases

◦ To add a database, do the following:

1. On the Action menu, click Add Database.
2. Enter the database and server information. (If you are using SQL Authentication,

enter the user name and password for that log in. If you are using Windows
Authentication, you must have already signed into the computer running the SLIM
Manager as an administrator with rights to the SQL Server; leave the fields blank.
See above sections on database connection credentials for more information.)

3. Select Service Control Manager in order for retention-related reporting, such as the
Inactive Records report and Eligible for Destruction report, to be handled as a
service.

4. Click OK.

Do not add the same database twice.

◦ To setup access to the database for TAB FusionRMS and Active Directory, do the following:

1. From the column on the left, click the plus (+) button, and then select the database.
2. Enable Active Directory.

c. Concurrent User Seats

◦ View Product, Host, and Time details of logged on users.
◦ To reserve a seat for a user, do the following:

1. Click Current User Seats.
2. On the Action menu, click Manage Seat Reservations.
3. Select Manual Add.
4. Enter a user name.
5. Click the arrow on the right and select the product you would like to associate with

the reserved seat.
6. Click Add.
7. Continue to add reserved seats for users as necessary.

Keep in mind that only one seat may be reserved for a user for each installed
application. Also, the number of available seats in the pool for each installed
application will be reduced by one for each reserved seat added.

3. Close or refresh SLIM Manager to enable new or modified settings, by doing the following:

a. On the File menu, click Exit or Refresh.

Database conversion

The first time the database is opened after an upgrade, you may see a message about updating your database to
the current version.

During this process, a new user is created with the user name administrator and the password password$. You
can use this account to open TAB FusionRMS and complete any necessary tasks, but it is recommended that you
change this password as soon as possible.
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Active Directory integration

TAB FusionRMS users and groups can be synchronized with the users of Active Directory. This feature helps
administrators with tedious tasks, such as adding large numbers of users, updating e-mail addresses, and disabling
user access.

When you perform the integration, you will map all of the Active Directory groups with the groups you create in
TAB FusionRMS. When you perform the synchronization, the mapped groups and all user information is brought
over to the TAB FusionRMS system. When users log in, they use the same user name, password, and domain
name that they would use to log in to their system. TAB FusionRMS will then authenticate this information through
Active Directory. If the log in fails, TAB FusionRMS will then attempt to authenticate this information using the TAB
FusionRMS information created during synchronization.

The synchronization can be performed manually or scheduled to run automatically. When Active Directory
synchronization occurs, only the TAB FusionRMS data is changed. Active Directory data is never altered—it is
only queried. This means that if you need to add a user, first add the user in your Active Directory system and
then perform a synchronization with TAB FusionRMS. User information should not be added or edited in the TAB
FusionRMS system; it will not be passed back to Active Directory.

Before you integrate with Active Directory you will need to set up your TAB FusionRMS groups and set the
permissions.

If you enable the Active Directory integration, you must map and synchronize the Administrator group to ensure access
to all areas of the system.

Procedure

To integrate (or map) and synchronize your Active Directory groups with TAB FusionRMS groups, do the following:

1. Open the SLIM Manager, the click the plus (+) button next to Databases.
2. Select your database from the list, then select Enable.
3. If found, your Active Directory domain, organizational units, and AD groups will load. If the wrong domain

has been found, enter a new one.
4. Select your organization unit.
5. Select your Active Directory group, then select the corresponding TAB FusionRMS group.
6. Click Map selected groups.
7. Continue to map your Active Directory groups and corresponding TAB FusionRMS groups.
8. If you make a mistake, select the item from the synchronization map, and then click Delete Mapping.
9. If you would like to create temporary tracking users if one does not exist in the tracking table, select Create

tracking employee. You can then select whether this should occur for all groups or a selected AD group.
This is a temporary entry that is created for the session at log in.

10. When you are finished, click Synchronize.

Active Directory with FusionRMS Web Access
To use the Active Directory settings with Web Access, you will need to make setting changes where the database is
published.

Procedure

To make the needed setting changes for Internet Information Services (IIS) setting, do the following:

1. On the Start menu, point to Administrative Tools, and then click Internet Information Services.
2. Under Web Sites, right-click Default Web Site, and then click Properties.
3. Select the Directory Security tab.
4. Under Authentication and access control, click Edit.
5. If selected, clear the Enable anonymous access.
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Synchronization: Manual and Automatic
If you need to force a synchronization because of important changes to your Active Directory system, you can open
the SLIM Manager, select your database, and then click Synchronize. Otherwise, the synchronization will occur
automatically every 30 minutes by default.

ADVANCED: The synchronization time can be edited.

Procedure

1. In the Program Files > TAB > SLIM Server directory, open the slimService.exe configuration file.

The file will open in Microsoft Visual Studio Tools.
2. Locate the line: <add key="SynchronizationInterval" value="30" />.
3. Edit the number in minutes.

0 (zero) means that the synchronization as a service will never run. All syncs will need to be performed
manually in the SLIM Manager.

It is recommended that you allow at least five minutes per database when setting the number of minutes.
Generally, the synchronization completes in just a few seconds or less, but depending on the amount of server
traffic, you should allow adequate time for the process to complete.

4. Save and Close

Image repository

The service responsible for managing the image repository will need read/write permissions. When hosting the
service in IIS, the ASP.NET account will need permission. When running as a Windows Service, the system account
will need permission.

Image Service file type exclusions

Each service has a configuration file containing a list of file types that are not processed for pages or a preview
image. The list is stored in Tab.RecordsManagement.Imaging.Export.dll.config.

For the Web Service, the configuration file is located in [Install Directory]\ImageServer\Bin.

For the Windows Service, the configuration file is located in [Install Directory]\Image Service.

In both cases, the list is stored in the configuration\applicationSettings
\Tab.RecordsManagement.Imaging.Export.MySettings\setting[name=’Exclusions’]\value section as a comma
delimited list. Files of these types can still be used as an attachment and opened in the native application; however,
they will not have a preview.

SQL database backup

The need to back up databases on a regular basis is a major component of managing any production system.
Members of the Admin group can access a basic built-in backup utility to handle making a full copy of a database
without having to use SQL Server Management Studio.

This is a manual process and can be performed at anytime. If you need more advanced backup options, use SQL Server
Management Studio to set functions such as performing differential backups or scheduling regular backups.

Procedure

To make a database backup, do the following:

1. In TAB FusionRMS, on the Tools menu, click Admin Manager.
2. In the Admin Manager, on the Tools menu, click Database Backup Wizard.
3. Follow the on-screen instructions.
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Program maintenance

After you have installed the TAB FusionRMS application and re-run the setup to add or remove extra components,
it’s important to understand the Custom Setup options.

After the Welcome screen, select Modify. On the Custom Setup screen, you can select the components you would
like to upgrade and/or install from the following options:

‣ The components listed with the computer image next to them were found on your local machine and will be
upgraded.
‣ The components listed with the red X were not found on your local machine. No action is required.
‣ If you select one of the components installed locally and switch it to the red X, that component will be removed

completely from your local machine.
‣ If you select one of the components with the red X and switch it to the computer image, it will be installed.

Known issues

Microsoft SQL Server Management Studio: When opening the Microsoft SQL Server Management Studio,
some users may encounter an error message concerning a file that could not be loaded (mscorlib.tlb). This is a
known issue with Microsoft and is not related to TAB FusionRMS and will not affect the use of the application. Visit
Microsoft’s site for further details and workarounds.

Upgrades and Microsoft Connectivity icons: TAB FusionRMS icons previously used to send documents to TAB
FusionRMS may still appear on the toolbar of the connected applications. These can be removed by accessing the
customization menu for each application and deleting them from the menu or toolbar. (JIRA SME-52)

Unable to Connect to License Server: If you are having trouble connecting to the License Server at the time
of log in, you may need to adjust your firewall settings. This issue was seen on systems running the server
components on Windows Server 2003. To resolve the issue, do the following:

1. on your server in your Windows Firewall Settings, add slimService.exe in the SLIM Server folder to the list
of Exceptions.

2. if you are still experiencing the connection error, at each computer using TAB FusionRMS, add
TabFusion.exe in the TAB folder to the list of Exceptions.

SQL Server Express 2005 and 2008: If you have already installed SQL Server Express 2005 or 2008 prior to this
installation, the default settings for the TCP/IP and Named Pipes are disabled. These will need to be enabled in
order for the Database Utility or the SLIM Manager to connect to the server.

Procedure

To enable TCP/IP and Named Pipes:

1. On the Start menu, right-click Computer, and then click Manage.
2. Open Services and Applications.
3. Open SQL Server Configuration Manager.
4. Open SQL Server Network Configuration.
5. Select Protocols for [SQLServerInstanceName].
6. Right-click both TCP/IP and Named Pipes, then and click Enable.
7. Stop and start the SQL Server service located in the Administrative Tools > Services > SQL Server

(SQLServerInstanceName).

Troubleshooting TAB FusionRMS

Windows Server 2003: If you are installing on Windows Server 2003, the ASP .NET web service extension is not
enabled by default. During the install, the service will be enabled automatically. If troubleshooting, check to see that
the service has been enabled.
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To enable ASP .NET Web Service Extension:

Procedure

1. Open the Internet Information Services (IIS) Manager.
2. Under the name of the server, click the Web Service Extensions folder.
3. Select ASP.NET, then click Allow.

Full Text Search: If no results are returned with a search or an error appears, you may need to set the FDHOST
Launcher (MSSLFDLauncher) Service Account for full-text search capabilities in the SQL Server Configuration
Manager.

Invalid column name error: Care should be taken by database administrators when manually removing a column
from the database. This error is received when searching within a view that maps to a column which does not exist.
The problem can be corrected by removing the reference to the missing column or by creating the column. (JIRA
SME-3511)

Troubleshooting attachments

No Images in Attachment Viewer: If you receive a message on the Attachment Viewer that there are no
attachments to display, but the header contains the correct title for the attachment, try to re-register ASP.NET for
IIS. The command prompt can be slightly different based on your operating system.

.Net 2.0 (32-bit): C:\Windows\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe -i
-enable

.Net 2.0 (64-bit): C:\Windows\Microsoft.NET\Framework64\v2.0.50727\aspnet_regiis.exe
-i –enable

Once you have finished re-registering ASP.NET, reset IIS. You can use the same command prompt and enter:

iisreset

500.0 Error: If you receive a 500 error, uninstall and then reinstall the web service.

404.3 Error: WCF needs to be registered. A batch file is available in the Extra folder > ImageServerWebService.
Right-click the file and select Run as administrator.

Troubleshooting Microsoft SQL Server Management Studio

Failed to retrieve data for this request (Microsoft.SqlServer.Management.sdk.sfc): If you receive this message
in Microsoft SQL Server Management Studio, then a database may be “offline” or SQL Server Management
Studio may not be able to read some data from a database. Open the Object ExplorerDetails pane by pressing
the F7 key while the Databases node is selected. Ensure that only the Name, Date Created, Policy Health,
and Owner columns are selected. Refresh the Databases node. Additional information can be found at http://
support.microsoft.com/default.aspx?scid=kb;EN-US;956179.

Troubleshooting the Database Utility

Program Compatibility Assistant: Windows 7 users may see the Program Compatibility Assistant display a
warning. Selecting This program installed correctly will get rid of the message. There are no known compatibility
issues with Database Utility on Windows 7.

http://support.microsoft.com/default.aspx?scid=kb;EN-US;956179
http://support.microsoft.com/default.aspx?scid=kb;EN-US;956179
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